PHOTOSHOP for ARTworks
Cool Tools & Techniques for Enhancing Images of Paintings, Sculptures, Drawings & Prints
Spring 2009
Photoshop CS3

PHOTOSHOP for ARTworks

for a PDF of Photoshop for Art Works (Photoshop CS3), see:
www.vraweb.org/resources/diag/photoshopresources.html
Mark Mathew Braunstein, Connecticut College
mark.braunstein@conncoll.edu
www.conncoll.edu/visual
PHOTOSHOP for ARTworks
Cool Tools & Techniques for Enhancing Images of Paintings, Sculptures, Prints & Drawings

page 2 – (this) Table of Contents

pages 3 to 5
PAINTING & other 2D Art
page 3 – **Color 1** – Color Settings, Auto Color, Levels, eyedroppers
page 4 – **Color 2** – Selective Color menu command
page 5 – **Other than Color** – Correct perspective distortion; Eliminate glare & lighting hotspots; Remove color casts; Correct lens distortion

pages 6 & 7
SCULPTURE (& 2D work)
page 6 – Eliminate distracting backgrounds & add shadows for illusion of depth
page 7 – Composite various views into one single image

pages 8 & 9
PRINTS & DRAWINGS
page 8 – **Cleanup** white paper & blacken dark lines; Preserve fine lines
page 9 – **Sharpen** (the right way)

pages 10 to 12
ALL MEDIA
page 10 – **PDF slideshow** to retain Adobe RGB color space
page 11 – **Add metadata** to safeguard against piracy
page 12 – **Create rubberstamp** for institutional logo or copyright

page 13
Recommended Readings
COLOR SETTINGS – Images intended for projection or websites concern issues not directly addressed here. Here is addressed color on your monitor. To significantly improve color’s dynamic range on your monitor, change Photoshop’s color space from its default sRGB to Adobe RGB (1998):
- EDIT menu → Color Settings
- Settings pull-down menu → Custom
- Color Management Policies → RGB pull-down menu → Convert to Working RGB (this is called tagging)
- click OK

For info about why or why not to “tag” images intended for the web:
http://www.gballard.net/psd/go_live_page_profile/embeddedJPEGprofiles.html

For info on why PC users should consider using Safari for PC or Firefox for PC:
http://news.cnet.com/2102-1012_3-6191815.html?tag=st.util.print

The above webpage links to this enlightening test image:
http://www.color.org/version4html.xalter

AUTO COLOR works wonders on 3/4 of all images, so is worth doing, even if 1/4 need undoing
- IMAGE menu → Adjustments → Auto Color   (CS4: IMAGE menu → Auto Color )
- EDIT menu → Undo Auto Color if needs (⌘ + Z)
- OR: EDIT menu → Fade Auto Color → set slider to the left as needed

AUTO LEVELS works wonders on most of those remaining 1/4 of images where Auto Color failed
- IMAGE menu → Adjustments → Levels (⌘ + L)
- Levels dialog box → click Auto Reset (option/alt) or Undo (⌘ + Z), if needs
  - OR: EDIT menu → Fade Levels → set slider as needed
- Levels dialog box → if Auto Levels not good, manually adjust Reset (option/alt) or Undo (⌘ + Z), if needs
- Levels dialog box → White Eyedropper, if needs
  - UNDO, if needs (⌘ + Z)
- click OK

LEVELS
adjust manually for remaining miscreant images resistant to improvement by either Auto Color or Auto Levels

SELECTIVE COLOR is the most powerful and efficient modifier of individual (selective!) colors
- IMAGE menu → Adjustments → Selective Color
- see next page
PAINTING – Other than Color

• instructions updated for Photoshop CS3 for Mac & PC
• ⌘ = Command key on Mac / Control key on PC
• underlined phrases = sorry, much more detailed instructions needed than provided here

1a – Correct perspective distortion (keystoning) of rectangles and squares
IF distortion is slight: Crop Tool (C) → draw crop, then on Options Bar checkmark …..Perspective → reposition each crop edge alongside artwork edge → return/enter
BUT IF distortion is excessive & you DO have Photoshop CS2 or CS3:
• Select menu → All (⌘ + A)
• Edit menu → Transform → Skew → to rectify right angles and retain proportions do not pull corner fully out, but only halfway out, and then pull other corner halfway in, creating a fulcrum upon the midpoint of the line → enter/return
• Select menu → Deselect (⌘ + D)
• Crop Tool (C) → crop out the now transparent corners → enter/return
OR IF distortion is excessive & you DO have Photoshop CS2 or CS3:
• Filter menu → Distort → Lens Correction → Transform → Vertical Perspective → slide left → OK
• Layer Menu → Flatten Image (because correction was created as a layer)
AND IF angle was extremely obtuse:
• Image menu → Image Size → checkmark Resample Image; uncheck Constrain Proportions; reduce (NOT increase) Width or Height to restore proportions → OK

1b – Eliminate glare on glass
• photograph from an angle so oblique that lighting is not reflected, then apply 1a (above)

1c – Rebalance lighting hotspots (or coldspots!)
• Layer menu → New Adjustment Layer → Levels (or Curves)
• Name dialog box → rename or accept Levels 1 (or Curves 1) → OK
• Make tonal adjustment → OK , then select Brush Tool (B) [or Paint Bucket tool (G)]
• Toolbar Color Picker arrows (X) → White reveals, Black conceals → paint away your troubles
• Window menu → Layers (F7) → poke out eye of adjustment layer to judge effect
• Layer Menu → Flatten Image

1d – Remove color casts
• Image menu → Adjustments submenu → Levels (% + L) → Auto &/or white eyedropper → OK
• OR – Image menu → Adjustments submenu → Hue/Saturation (% + U) → Edit pull-down menu: Cyans or whichever color → Saturation slider: -50 to -100 → OK
• OR – Image menu → Adjustments submenu → Selective Color → Colors menu: Cyans or whichever color → Black slider: -50 to -100 → Method: Absolute → OK

1e – Correct lens distortion usually barrel-vaulting of wide-angle lenses
• Filter menu → Distort → Lens Correction → Settings pull-down menu → Custom
• Remove Distortion top slider → +1.00 or +2.00, etc; OR type +1.50 or +2.50, etc; OR click on upper left corner Remove Distortion Tool (D) & click & drag on image → OK
  (correct for pin-cushioning distortion of telephoto lenses with -1.00 or -2.00, etc)
• Layer menu → Flatten Image (because correction was created as a layer)
**SCULPTURE 1** (& 2-D works)

© instructions for Photoshop CS3 for Mac & PC  ℗ = Command key on Mac / Control key on PC

_**Eliminate distracting backgrounds** (& add shadows for illusion of depth)_

**METHOD ONE:**
Not always effective, but usually easy, as it avoids making time-consuming _Selections_:
- **Blur Tool** (R) → *Option Bar: Brush* pull-down menu → *Hardness: 0% & Master Diameter: Large; Option Bar: Strength 100%* to start, but increase *Hardness* (which really means increase its softness) and reduce *Master Diameter* & reduce *Strength* the closer you work near the actual artwork

**METHOD TWO:**
If the artwork’s colors differ widely from the background’s colors, this too is quicker than making _Selections_:
- **Image** menu → *Adjustments* → *Hue/Saturation* ($+$ + U) → *Edit* pull-down menu: choose & repeat for all colors other than artwork’s → *Saturation* slider: -100 → OK
- optional: **Image** menu → *Adjustments* → *Selective Color* → *Colors* pull-down menu: Blacks, then move bottom slider _Black_ to far RIGHT (be sure _Method_ button → _Absolute_) → click OK
- if needed, repeat _Selective Color_ procedure

**METHOD THREE:**
If you possess skill and fortitude for making _Selections_, this is very cool:
- **Layer** menu → *Duplicate Layer* → OK & proceed to work on _Background Copy_
- apply any combination of _Selection Tools_ (especially the _Quick Selection Tool_, new to CS3) to artwork OR to background, whichever is more efficient
- if applied to artwork, **Select** menu → _Inverse_
- EITHER CS2: to rid fringe, **Select** menu → *Modify* → *Expand* → *Expand By: 1 pixels* → OK
- OR CS3: to eliminate fringe, on the Selection tool’s _Options_ bar → _Refine Edge_
- optional: **Paint Bucket Tool** (G) → *Option Bar: Tolerance 100%* → **Color Picker**: _Neutral Gray_ → pour onto selection
- to add shadows for depth: **Filter** menu → **Blur** → **Gaussian Blur** → *Radius: adjust to taste* → [[[if needed: **Image** menu → *Adjustments* → *Desaturate*]]] → OK
- **Blur Tool** (R) → *Option Bar: Hardness 0% & Strength 100%* → smooth out edges
- **Window** menu → **Layers** (F7) → *Layers* palette → _Background Copy_ → Normal effect & adjust _Opacity_ slider; OR _Overlay effect & Opacity: 100%; OR Saturation effect & Opacity: 100%
- **File** menu → **Save As** → **Save As** dialog box → *Format: Photoshop* → **Save**
- **Layers** menu → **Flatten image**
- **File** menu → **Save As** → **Save As** dialog box → *Format: TIFF* renamed → **Save**

_Some notes about _Selection_ tools:_
- **Filter** menu → **Extract** was new for CS3, but was dumped from CS4
- **Magic Wand** Tool was magic years ago, but the magic has died. New in CS3 is _Quick Selection Tool_
- **Background Erase** Tool works magic if pasting the sculpture into a transparency layer → _Options_ bar, select _Left Eyedropper_; set _Tolerance_ to 30% to start → click and release its center crosshairs on what you want to erase, then overlap its outer edges over the sculpture, hold the click, trace around the object, and watch your edge fringes disappear

---

for PDF of Photoshop for Art Works  www.vraweb.org/resources/diag/photoshopresources.html
Copyright? [© Not] -- Permission granted for reproduction with attribution:
Mark Braunstein -- Connecticut College -- mark.braunstein@conncoll.edu
SCULPTURE 2 (& 2-D works)

- instructions updated for Photoshop CS3 for Mac & PC
- ⌘ = Command key on Mac / Control key on PC
- underlined phrases = sorry, much more detailed instructions needed than provided here

Composite various views into one single image

Either: A) To composite a smaller image onto a larger one
When viewed on your monitor, you can gain an accurate idea of how the images compare in size only if they share the same dpi resolutions
- To view only: on bottom frame of window of image, click on the black right arrow → scroll down to Show → pull-down menu to Document Dimensions → (?? ppi)
- Or to view & resample (resize): Image menu → Image Size → Resolution: ?? pixels/inch

Next, open both images, & then:
- select (single-click) the smaller one → Select menu → All (⌘ + A)
- while still on smaller image → Edit menu → Copy (⌘ + C)
- select (single-click) the larger one → Edit menu → Paste (⌘ + V)
- select Move Tool (V) top icon on Tool Bar, to move the smaller image into position

To resize the top image to make it smaller:
- first verify its layer is selected → Window menu → Layers (F7)
- Edit menu → Transform → Scale → hold down Shift key to maintain proportions, then click & drag on corner or side of top image

OR: B) To combine two or more images side-by-side, you need to expand the canvas of one
- Image menu → Canvas Size → Canvas Size dialog box → EITHER increase Width and then Anchor to Left or Right, OR increase Height and then Anchor to Top or Bottom → OK

Next, open other image(s), & then:
- select (single-click) the second image → Select menu → All (⌘ + A)
- while still on second image → Edit menu → Copy (⌘ + C)
- select (single-click) the first image → Edit menu → Paste (⌘ + V)
- select Move Tool (V) top icon on Tool Bar, to move the second image into position

For both A & B:
To retain layers, reformat this newly composited image into a Photoshop file (PSD):
- FILE menu → Save As (shift + ⌘ + S) → Format: scroll to top of pull-down menu → Photoshop → Save

To flatten layers in preparation of reformatting the PSD image into a TIFF or JPEG:
- Layer menu → Flatten Image (2nd to last item)
PRINTERD & DRAWINGS 1

- instructions updated for Photoshop CS3 for Mac & PC
- \textit{\$} = Command key on Mac / Control key on PC
- underlined phrases = sorry, much more detailed instructions needed than provided here

.cleanup white paper and blacken dark lines

EITHER use \textbf{EYEDROPPERS}

\begin{itemize}
\item \textbf{Image} menu \textit{\rightarrow} \textbf{Adjustments} submenu \textit{\rightarrow} \textbf{Levels} \textit{\rightarrow} apply white eyedropper \& sometimes also black eyedropper \textit{\rightarrow} \textbf{OK}
\end{itemize}

OR use \textbf{LEVELS}

\begin{itemize}
\item \textbf{Image} menu \textit{\rightarrow} \textbf{Adjustments} submenu \textit{\rightarrow} \textbf{Levels} \textit{\rightarrow} move Shadows \& Highlights sliders beyond edges of and actually penetrating past borders of \textbf{Histogram} \textit{\rightarrow} \textbf{OK}
\end{itemize}

&/OR use \textbf{SELECTIVE COLOR}

\begin{itemize}
\item if image is grayscale, convert to color: \textbf{Image} menu \textit{\rightarrow} \textbf{Mode} \textit{\rightarrow} RGB Color
\item \textbf{Image} menu \textit{\rightarrow} \textbf{Adjustments} \textit{\rightarrow} \textbf{Selective Color} \textit{\rightarrow} procedures that follow may seem complicated, but are actually the same procedure with three slight variations
\item start at bottom, \textit{Method} button \textit{\rightarrow} Absolute \textit{(not Relative)}
\item at top, \textit{Colors} pull-down menu \textit{\rightarrow} default is \textit{Reds}, scroll down to \textit{Whites}, then move bottom slider \textit{Black} to far LEFT (which is \textit{White}, really), and while \textit{Black} \& \textit{White} adjustments can be done together, better to apply them separately, so \textit{\rightarrow} \textbf{OK}
\item reopen \textbf{Selective Color}, and for blacker blacks, \textit{Colors} pull-down menu \textit{\rightarrow} \textit{Blacks}, then move bottom slider \textit{Black} to far \textit{RIGHT} \textit{\rightarrow} \textbf{OK}
\item if needed, reopen \textbf{Selective Color}, and for whiter whites, repeat above \textit{White} step
\item if needed, reopen \textbf{Selective Color}, and for blacker blacks, \textit{Colors} pull-down menu \textit{\rightarrow} Neutrals \textit{(NOT Blacks)}, then move bottom slider \textit{Black} to near \textit{(not far)} LEFT \textit{\rightarrow} \textbf{OK}
\item if image was grayscale, to reconvert back, \textbf{Image} menu \textit{\rightarrow} \textbf{Mode} \textit{\rightarrow} Grayscale
\end{itemize}

& if needed, apply \textbf{MULTIPLY}

\begin{itemize}
\item \textbf{Layer} menu \textit{\rightarrow} \textbf{Duplicate Layer} \textit{\rightarrow} \textbf{Duplicate Layer} dialog box \textit{\rightarrow} \textit{As: Background copy} \textit{\rightarrow} \textbf{OK}
\item \textbf{Window} menu \textit{\rightarrow} \textbf{Layers} \textit{\rightarrow} \textbf{Layers} palette \textit{\rightarrow} \textit{Normal} pull-down menu \textit{\rightarrow} \textit{Multiply}
\item \textbf{Layer} menu \textit{\rightarrow} \textbf{Flatten Image}
\end{itemize}

Preserve fine lines

\textbf{Sharpening} yields good results only when painstakingly applied, so is better omitted except for fine lines, yet even here \textit{Shadows/Highlights} can prove more effective. During the procedure, \textbf{Zoom in} on image to 100%

\begin{itemize}
\item \textbf{Image} menu \textit{\rightarrow} \textbf{Adjustments} \textit{\rightarrow} Shadow/Highlight \textit{\rightarrow} \textit{Highlights} leave at 0%, \textit{Adjustments} leave at default, but \textit{Shadows} default is always excessive, reset default to \textit{Amount: 33\%}, \textit{Tonal Width: 16\%}, \textit{Radius: 33px} \textit{\rightarrow} \textbf{Save As Defaults} \textit{\rightarrow} \textbf{OK}
\item if needed, reopen \textit{Shadow/Highlight} and apply again
\item if needed, apply two \textbf{Selective Color} steps for blacker blacks as described above
\end{itemize}

See next page for how to \textbf{Sharpen (the right way)}
SHARPEN (the right way)

Sharpening alters the image irreversibly, so retain an unsharpened master and instead work on a duplicate file. The TIFF must be completed because sharpening is best done as the very last step. So first create a duplicate of your completed TIFF, and add to its file name the word “-sharp”.

Two advanced techniques for SHARPENING are this Lab Color Dial-In method and the High Pass method. For High Pass, a free tutorial from Photoshop CS2 – Essential Skills by Mark Galer, can be viewed at: http://www.photoshopsupport.com/tutorials/sharpen-an-image/photo-sharpening.html

Now for the Lab Color Dial-In method for images only in RGB, not in CMYK:

1 – ZOOM (Magnifier) Tool (Z) - double-click to view image at 100%

2 – IMAGE menu → Mode → Lab Color (your mode until now was RGB)

3 – WINDOW menu → Channels → select Lightness channel (⌘+1)

4 – FILTER menu → Sharpen → Unsharp Mask (CS2 and thereafter provide also Smart Sharpen, a euphemism for Smart but Slow Sharpen)

5 – Unsharp Mask dialog box: Amount: 500%; Radius 0.1 pixels; Threshold: 6 levels; and note that because Radius is set to minimum, you see no change despite the 500%

6 – Click on Radius white fill-in box, and SLOWLY scroll-dial up (OR click and drag to right the Radius cyan-colored slider) while viewing result, until you reach the one critical increment that applies a very drastic change (pop!). This usually is between 0.5 and 1.5 pixels. Hold-click in preview box to compare “before” & “after.” Having identified the critical pop!, decide between this pop! Increment (much sharpening) or the non-pop increment before it (less sharpening). Either is too much to retain, hence the next step.

7 – Click on Amount white fill-in box, and scroll-dial down (OR click and drag to left the Amount cyan-colored slider) until sharpening renders an acceptable effect, then click OK

8 -- IMAGE menu → Mode → RGB

9 – if your original image is in CMYK, not RGB, of if you are simply lazy, an easier but slightly less effective alternative to converting to Lab Color mode is to omit steps 2, 3, and 8, and instead now go to EDIT menu → Fade Sharpen… → Fade dialog box → Mode pull-down menu: Luminosity (NOT Lighten) → click OK
PDF Slide Show to retain Adobe RGB color space

- instructions updated for Photoshop CS3 for Mac & PC
- **⌘ = Command key on Mac / Control key on PC**

The PDF Slide Show component of Photoshop is little known and underutilized. While it's been moved from Photoshop CS4 into Bridge CS4, in CS3 it still is found in Photoshop. While not as flexible for making changes as is PowerPoint, this PDF enables **preservation of Adobe RGB (1998) color space**, whereas PowerPoint mangles color. You do NOT need Photoshop to view the slideshow, just a PDF reader such as Adobe Acrobat Reader or Mac’s Preview.

1) Create a folder of resized & compressed JPEGs (1024x768 pixels for projection, 1680x1050 pixels for higher res monitors); the first jpeg preferably of text instructing of navigation; the jpegs arranged in numerical order (01xxx.jpg, 02xxx.jpg); the folder potentially named *jpegs4slideshow*

2) **FILE** menu → **Automate** → **PDF Presentation** → dialog box opens

3) **Source Files** window
   - **Browse** → navigate to folder → highlight 1st image, then depress **SHIFT** key & highlight last image [ or Select All (**⌘ + A**) ] → **Open** → images now listed in **Source Files** window

4) **Output Options** dialog box (these are recommendations, not edicts)
   - **Save As**: Presentation / Background: Black (Mac only) / Include: Filename or omit all

5) **Presentation Options** dialog box (these are recommendations, not edicts)
   - uncheckmark **Advance Every …** / checkmark **Loop after Last Page** / **Transition**: Box Out
   - click **Save**

6) **Save** dialog box
   - **File name** (Mac: **Save As**): Whatever.pdf / **Save in** (Mac: **Where**): Desktop / click **Save**

7) **Save Adobe PDF** dialog box
   - **General**: defaults fine, with addition checkmark of **View PDF After Saving**
   - **Compression**: if you already customized JPEGS at #1 above, then **Do Not Downsample & Image Quality**: Medium
   - **Output**: here is where you assure the preservation of your color space!!!
     - **Color**: **Color Conversion** pull-down menu: **Convert to Destination**
     - **Color**: **Destination** pull-down menu: **Adobe RGB (1998)**
   - **Security**: omit [what is this? Alcatraz?]?
   - click **Save PDF**

8) Images are processed; then **PDF** folder loads to desktop; after long pause, slideshow opens

9) (Mac only) **Full Screen** dialog box → checkmark **Remember my choice**, then choose **Yes**

10) Screen blacks out for approx 15 seconds, then first image appears; to navigate:
   - **FORWARD**: **Left-Click** mouse or **Right Arrow** key
   - **REVERSE**: **Right-Click** mouse or **Left Arrow** key
   - **EXIT** slide show: **ESC** (escape) key
   - **RETURN** to slide show: **Window** menu (or **View** menu) → **Full Screen View**

---

*for PDF of Photoshop for Art Works [www.vraweb.org/resources/diag/photoshopresources.html]*

*Copyright? [© Not] – Permission granted for reproduction with attribution:
*Mark Braunstein -- Connecticut College – mark.braunstein@conncoll.edu*
Add METADATA to Safeguard against Piracy

instructions for Photoshop CS3 for Mac & PC

⌘ = Command key on Mac / Control key on PC

Create a metadata template for XMP / IPTC windows

[Extensible Metadata Platform / International Press Telecommunications Council]

- File menu → File Info → Toggle Bar on left, choose Description &/or IPTC Contact &/or IPTC Status &/or Origin etc window(s), though Description being first is sufficient

- Type your intended text, for instance © Your Name or © Institutional Name. For © symbol → Option + g on Mac keyboard, or Alt + 0169 on Windows numeric keypad. Not all XMP / IPTC readers work identically, so you may wish to repeat info in several fields within same window, and across several windows.

- To save the metadata as a template, from any window, click on right fly-out menu on top right corner, its icon is the black right arrow triangle inside a circle (not inside a square) → Save Metadata Template → Template Name: Copyright1 (or Whatever1) → Save

- Thereafter, to add same metadata to any image, File menu → File Info → click on right fly-out menu on top right corner → Copyright1 (or Whatever1) → metadata then populates the previously blank fields → OK

Batch process metadata from templates into images
easier using Bridge CS3 (Tools menu → Append Metadata) because to do so in Photoshop you must create an action (script)

To create a Photoshop action (script)

- File menu → Open a test image → Window menu → Actions → Actions palette right fly-out menu (black triangle) → New Action → Name: Copyright1 (or Whatever1) → Record
- File menu → File Info → click on right fly-out menu on top right corner → Copyright1 → metadata populates the previously blank fields → OK
- File menu → Save
- File menu → Close (this necessary final step is too easily and too often omitted)
- Actions palette right fly-out menu → Stop Recording (or Actions palette bottom bar, click on black square)

Apply this action in 1 of 3 ways
1. apply an ACTION to a single image: Open your image → Window menu → Actions → select your Copyright action → on Actions palette bottom bar, click on right arrow
2. apply a DROPLET to single image: File menu → Automate → Create Droplet
3. apply a BATCH PROCESS to a folder of images: File Menu → Automate → Batch

for PDF of Photoshop for Art Works  www.vraweb.org/resources/diag/photoshopresources.html
Copyright? [© Not] – Permission granted for reproduction with attribution:
Mark Braunstein -- Connecticut College -- mark.braunstein@conncoll.edu
Create **RUBBERSTAMP** for Copyright
of “© Your Name” or “© Your Institution”

- While called and created as a “brush,” think of this instead as a rubberstamp
- Instructions updated for Photoshop CS3 for Mac & PC
- ℘ =  Command key on Mac / Control key on PC

1a) To create and save as a BRUSH:
- **File** menu ➔ **Open** (℘+O) a large file (at least 20MB) TIFF test image
- **Toolbar ➔ Type Tool** (T) ➔ on **Options Bar**, select font & color & size large enough to reach across entire image ➔ type “© Your Name”—– for “©” symbol: **Option key + g** (Mac); **Alt key + numeric keypad 0169** (PC)
- **Window** menu ➔ **Layers** (F7) ➔ hide **Background Layer** by poking out eye icon on left edge of **Layer** palette, then select the **Type layer**
- **Select** menu ➔ **Color Range** ➔ **Fuzziness** slider ➔ extreme right to 200 ➔ **OK** (the text now should be crawling with marching ants)
- **Edit** menu ➔ **Define Brush Preset** ➔ name it Copyright1 (or Whatever1) ➔ **OK**
- **File menu ➔ Save** (℘+S) if you wish

1b) To use your new BRUSH:
- **File** menu ➔ **Open** (℘+O) your target image
- **Toolbar ➔ Brush Tool** ➔ on 2nd component of **Options Bar** along top of screen (or right-click on image), is **Brush**: scroll to bottom for your new brush Copyright1 ➔ adjust slider on **Opacity** (or type in percentage) & on **Master Diameter** (or type in pixels, and be aware that having created brush with a large font, now you can reduce size as needed) ➔ apply brush by left-clicking on image
- **Layer** menu ➔ **Flatten Image**

OR

2a) To create and save as a LAYER:
- **File** menu ➔ **Open** (℘+O) a large file (at least 20MB) TIFF test image
- **Toolbar ➔ Type Tool** (T) ➔ on **Options Bar**, select font & color & size large enough to reach across entire image ➔ type “© Your Name” for “©” symbol: **Option key + g** (Mac); **Alt key + numeric keypad 0169** (PC)
- **Window** menu ➔ **Layers** (F7) ➔ delete **Background Layer** by dragging it to **Trash** icon on bottom right corner of **Layer** palette
- **File menu ➔ Save As** ➔ **Save As** dialog box ➔ **Format**: Photoshop / **Save As**: Copyright1.psd (or Whatever1.psd) ➔ **Save**

2b) To use your new LAYER:
- **File menu ➔ Open** (℘+O) your target image
- **File menu ➔ Open** (℘+O) your new Copyright LAYER image
- **Window** menu ➔ **Layers** (F7) ➔ drag **Copyright LAYER** from **Layer** palette onto target Image
- **Toolbar ➔ Move** tool (V) ➔ move text to position you want it on target image
- **Layer** menu ➔ **Flatten Image**

for PDF of Photoshop for Art Works  www.vraweb.org/resources/diag/photoshopresources.html
Copyright? [© Not] – Permission granted for reproduction with attribution:
Mark Braunstein -- Connecticut College – mark.braunstein@conncoll.edu
First, you need Photoshop. Trying to learn Photoshop without the actual use of Photoshop presents insurmountable obstacles. So download free trial versions of Photoshop CS4 or Photoshop Elements 6 for Mac or 7 for PC at: http://www.adobe.com/downloads

Next, you need help. Web-based tutorials can be accessed through the HELP menus of both CS3 & Elements 6 or 7. In addition, World Cat in Jan 2009 listed 5622 books with Photoshop in their titles and another 681 with Photoshop Elements. (This tally omits videos & CDs & DVDs & websites.) You need only the few that specifically address photo retouching, which is mostly what you’ll ever do, and for what Photoshop 1.0 (1990) solely was intended. All books cited are paperbound and most are published by Peachpit Press, the most dependable single source for computer manuals.

✈️ [Adobe] Photoshop CS3 Book for Digital Photographers
Its suitable subtitle is “Photoshop Fun 101.” Filled with (sometimes distracting) humor, the lively text is fun to read. Yes, read. Most Photoshop manuals are intended to be referenced, not read, but with its spacious & clear graphics this stand-alone book can be read when you are unchained from your computer. If compelled to recommend one Photoshop manual above all others, I would choose this. View all Kelby Photoshop books at: http://www.kelbytraining.com/books

✈️ Photoshop Elements 7 Book for Digital Photographers
“Reach out & retouch someone.” Offers techniques for rendering photo retouching effects similar to CS3 tools and commands that Elements lacks. See comments above about Kelby's CS3 book.

✈️ [Adobe] Photoshop Restoration & Retouching, 3rd Edition
Katrin Eismann; Peachpit Press; 472 pages; $50
Whereas Kelby stands up and cracks jokes, Eismann sits down, gets to work, and possibly never again gets up. The next step after Kelby, if not the last step, palatable only in small doses.
Sample chapter download Damage Control at: www.peachpit.com/store/product.aspx?isbn=0321316274

✈️ Adobe Photoshop Lightroom & Photoshop [CS3] Workflow
Mark Fitzgerald; www.wiley.com/go/workflow 560 pages; $45
How to get that image from camera to projector in 3 easy steps (we wish!). OK, so it really takes 300 complex steps, otherwise you would not need this book.

✈️ Adobe Photoshop Master Class: John Paul Caponigro, Second Edition
Photograph as art (“This book attempts to put the photography back into Photoshop.”), and Photoshop manual as philosophy (“A good memory knows not only what to remember, but also what to forget.”). Inspiring images paired with pondering prose, intended to be read away from your computer. Published 2003, almost ancient, but not version specific, so still relevant today.

✈️ Adobe Photoshop CS3 Classroom in a Book
For beginners who prefer to learn everything before doing anything (and thereby risk accomplishing nothing). Sample chapter free download Basic Photo Corrections is “good for nothing” at: www.peachpit.com/articles/article.asp?p=471938&rfl=1

for PDF of this document, see: http://www.vraweb.org/resources/diag/photoshopresources.html

Copyright? [© Not] – Permission granted for reproduction with attribution:
Mark M. Braunstein – Visual Resources – Connecticut College – mark.braunstein@conncoll.edu